Drawing Section Views
and
Graphic Patterns

Sacramento City College
Engineering Design Technology
Objectives

- Identify sectioning techniques.
- Use sections and dimensioning practices to draw objects given in engineering sketches.
- Draw section material using the BHATCH, HATCH, and SOLID commands.
Objectives

◆ Prepare graphic displays, such as graphs and logos, using the BHATCH and SOLID commands.

◆ Edit existing associative hatch patterns using HATCHEDIT.
Sectioning and Section Views
Sectioning and Section Views

- In mechanical drafting, internal features in multi-views appear as hidden lines.
- It is poor practice to dimension to hidden lines,
  - But these features must be dimensioned.
- Section views are used instead, to clarify the hidden features.
Sectioning and Section Views

- **Section views** show **internal features** as if a portion of the object is cut away.

- **Section views** are used with **multi-views** to completely describe the exterior and interior features of an object.
Section Views/Cutting Plane Lines

重要内容

1. 当截面图被绘制时，一段截切平面线会被放在其中一个视图中，以显示截切的位置。

2. 截切平面线是切割入对象内部，以暴露内部特征的锯子。
Cutting-Plane "Knife"

Fig. 9-9 The cutting-plane line represents the edge view of the cutting plane.
Cutting Plane lines have two forms:

- A thick hidden (evenly spaced dashed) line.
- A phantom line in accordance with ASME Y14.2M.
Section Views/Cutting Plane Lines

- The arrows on the cutting-plane line indicate the direction of sight when looking at the section view.
Section Views/Cutting Plane Lines

- **The cutting-plane lines** are labeled with letters that relate to the proper section view.

- The section name, **SECTION A-A**, is placed _under_ the view.
Normal Views

Isometric Pictorial View

Top View

Front View

Right Side View
Cutting-Plane

Section View C
Section Views/Cutting Plane Lines

- The arrows on the cutting-plane line indicate the line of sight when looking at the section view.
Section Views/Cutting Plane Lines

- The cutting-plane lines are labeled with letters that relate to the proper section view.
- SECTION A-A, is placed under the view.
Section Views/Cutting Plane Lines

- When more than one section view is drawn, labels continue with B-B through Z-Z.
**Drawing Section Views and Graphic Patterns**

- **Section lines**
- **SECTION A-A**
- **Section-view label**
Section Line Rules
Section Line Rules

1. **Section** lines are placed at 45° unless another angle is required to satisfy the next two rules.

Avoid section lines placed at angles greater than 75° or less than 15° degrees from horizontal.
Section Line Rules

2. Section lines should **not be** drawn parallel or perpendicular to any other adjacent lines on the drawing.

Section lines are NEVER drawn parallel to or at right angles to visible lines.

Refer to Figure 9-8
Section Lines/Object Lines

Figure 9-8
POOR PRACTICE
Section Lines/Object Lines

Figure 9-8

POOR PRACTICE
Section Lines/Object Lines

Figure 9-8

CORRECT
Section Line Rules

3. Section lines should **not cross object lines**. 
Types of Sectional Views
Types of Sectional Views

- Types of Sections:
  - Full Sections.
  - Offset Sections.
  - Half Sections.
  - Broken-Out Sections.
  - Revolved Sections.
  - Removed Sections.
  - Auxiliary Sections.
  - Phantom (Hidden) Sections.
Full Sections
Full Sections

- A **full section** is a sectional view that shows an object as if it were **cut completely apart** from one end or side to the other.

- **Full sections** remove **half** the object.

- In **full sections**, the **cutting-plane line passes completely through** the object along a center plane.
Full Sections

These views are sometimes just called sections.
Front View

TOP VIEW

FRONT VIEW
Full Section

TOP VIEW

FRONT FULL-SECTIONAL VIEW
Full Sections

◆ The two most common types of full sections are

◆ vertical and

◆ profile sections.

◆ Refer to Figures 9-17 and 9-18.
Fig. 9-17  Vertical section.
Fig. 9-18  Profile section.
Sectioning

Sectioning is also used in other drafting fields, such as architectural and structural drafting.

Cross sections through buildings show the construction methods and materials.
24" MEDIUM CEDAR SHAKES
(10" EXPOSURE)
30# FELT E.A. COURSE
1 X 6 SPACED SHEATHING
2 X RAFTERS & CLG. JSTS.
(OR TRUSSES- SEE ROOF PLAN)
R-38 BLOWN-IN INSULATION
\( \frac{5}{8} \)" GYPSUM BD. CEILING

INSUL. BAFFLE @ EAVE VENTS
"SIMPSON" H2.5 SEISMIC CLIPS
2 X SOLID BLKG. W/ 2 X 12
SCREENED VENTS @ 6'-0" O.C.

G.I. GUTTER ON 2 X 8 FASCIA

\( \frac{1}{2} \) X 6 BEVEL CEDAR SIDING
15# BLDG. PAPER (OR TYVEK)
\( \frac{1}{2} \)" CDX PLYWOOD SHEATHING
2 X 6 STUDS @ 16" O.C.
R-19 BATT INSULATION
\( \frac{1}{2} \)" GYPSUM BD.
FLOOR FINISH
5/8" PART. BD. UNDERLAY
3/4" T & G PLYWOOD SUBFLOOR
2 X FLOOR JOISTS (SEE PLAN)
R-19 BATT INSULATION
CRAWLSPACE
6 MIL BLACK "VISQUEEN"

2 X 6 P.T. MUDSILL WITH
1/2" A.B. @ 48" O.C. (MIN.
OF 2 PER 12 AND WITHIN
12" OF ANY CORNER)

SLOPE

4" Ø PERFORATED DRAIN
TILE (TYP. WHERE REQ'D)

- SINGLE STORY AREAS USE
6" FDTN. ON 12" X 6" FTG.

TYP. WALL SECTION

SCALE: 3/4" = 1'-0"
Offset Sections
Offset Sections

- **Offset sections** are almost the **same** as **full sections**.

  - **Difference**: the cutting-plane line is staggered.

- The **line cuts** through features that are **not** in a **straight line**.
Offset Section - Figure 9-19

TOP VIEW

D

FRONT VIEW

TOP VIEW

OFFSET-SECTIONAL VIEW
Drawing Section Views and Graphic Patterns
Offset Section

[Diagram of top and front views with section views and patterns]

TOP VIEW

D

FRONT VIEW

OFFSET-SECTIONAL VIEW

E
Half Sections
Half Sections

A half section is one half of a full section.

Half sections show one-quarter of the object removed.

The term half section is used because
  - Half of the view appears in section.
  - The other half is shown as an exterior view.
Half Section

Drawing Section Views and Graphic Patterns

TOP VIEW

FRONT VIEW

HALF-SECTIONAL VIEW

TOP VIEW
Half Sections

- Half sections are commonly used on symmetrical objects.

- Both the inside and outside can be shown in one view.
**Half Sections**

- A *centerline* is used to separate the *sectioned part* of the view from the *un-sectioned part*.

- *Hidden lines* are normally omitted from the un-sectioned side.
**Half Sections**

- Use a *centerline* where the exterior and half-sectional views meet since the *object is not actually cut*.

HALF-SECTIONAL VIEW
Half Sections

- In the top view, **show the complete object**, since no part is actually removed.
- Use **one arrow** for the direction of viewing.
Half Sections
Broken Sections
Breaking Sections

A **broken-out section** shows an object as it would look if a portion of it were **cut partly away** from the rest by a cutting-plane and then "**broken off**" to reveal the cut surface and insides.

- Refer to Figure 9-21
PHOTOGRAPH OF DOUBLE PACKING GLAND
Broken Sections - Figure 9-21

GLAND WITH CUTTING PLANE
Broken Sections - Figure 9-21

PART OF GLAND MOVED AWAY TO EXPOSE CUT SURFACE
Broken Sections

- A broken-out section show some inside detail without drawing a full or half-section.
Broken Sections

- The broken-out section is bounded by a short-break line drawn freehand the same thickness as visible lines.
  - Refer to Figure 9-22
**Broken-out Sections**

- **Broken-out sections** show only a small portion of the object removed.

- **Broken-out sections** clarify hidden features.
Broken Sections - Figure 9-21

TOP VIEW

FRONT VIEW
Broken Sections - Figure 9-21

TOP VIEW

FRONT VIEW WITH BROKEN-OUT SECTION
Fig. 9-22 Two additional examples of broken-out sections.
Broken Sections - Figure 9-21
Aligned Sections
Aligned Sections

- **Aligned sections** are used when a **feature** is **out of alignment** with the **center plane**.

- An **offset section** will distort the image.
Aligned Sections

- The cutting-plane line cuts through the feature to be sectioned.

- The feature is then rotated to align with the center plane before projecting into the section view.
Rotate to center plane

Project to section view
Revolved Sections
**Revolved Sections**

- Revolved sections clarify the contour of objects that have the same shape throughout their length.

- The section is revolved in place within the object, or part of the view may be broken away.
Revolved Sections

- Use a revolved section:
  - When the part is long and thin.
  - When its shape in cross section is the same throughout.
Fig. 9-23  Cutting plane in position for revolved section.
Revolved Section

MOST COMMON METHOD
Revolved Section

Fig. 9-24  Revolved section.
Revolved Section

- The view may be shortened.

- Give the full-length of the part by a dimension.

- This lets you draw a large part with a revolved section in a short space.
Revolved Sections

PARALLEL (SAME SLOPE)
Revolved Sections

Fig. 9-25  Revolved sections in long parts.
Removed Sections
Removed Sections

- Removed sections serve much the same function as revolved sections.

- The section view is removed from the regular view and moved somewhere else on the drawing sheet.
Removed Sections

◆ A removed section is taken from its normal place on the view and moved somewhere else on the drawing sheet.

◆ A cutting-plane line shows where the section was taken.
**Removed Sections**

- When **multiple removed sections** are taken, the cutting planes and related views are labeled.

- Drawing only the ends of the cutting-plane lines simplifies the views.
**Removed Sections**

- The removed section must be positioned to look as if it were in its normal place on the view.

- The removed section cannot be rotated in just any direction!

- Refer to Figure 9-26 for examples
Removed Sections

◆ When multiple removed sections are taken, the cutting planes and related views are labeled.

◆ Drawing *only* the *ends* of the *cutting-plane* lines *simplifies* the views.
Removed Sections

RIGHT

SECTION A–A

SECTION B–B

WRONG

SECTION B–B

SECTION A–A
Removing Sections
Auxiliary Sections
**Auxiliary Sections**

- An auxiliary section is a view which is produced when a cutting plane line passes through an object at an angle.
  - Refer to Figure 9-27A

- An auxiliary section is drawn like any other auxiliary view.
Auxiliary Sections Figure 9-27
Auxiliary Sections  Figure 9-27

Fig. 9-27 Auxiliary section.
Phantom (Hidden) Sections
Phantom (Hidden) Sections

- A **phantom section** is used to show **one view** both of the **inside** and **outside** of an object that is **not completely symmetrical**.
Phantom (Hidden) Sections

- Since the object is not symmetrical, the inside cannot be shown with a half section.
- A phantom section is used instead.
- Refer to Figure 9-28.
Phantom Sections  Figure 9-28
Drawing Section Lines and Hatch Patterns with AutoCAD
Section Lines/Hatch Patterns

- Use the BHATCH command
  - Automatically hatches any enclosed area.
  - Select Hatch patterns
  - Apply using the Boundary Hatch dialog box.
Section Lines/Hatch Patterns

Access this dialog box with the BHATCH command by:

- Picking the Hatch button on the Draw toolbar
- Picking Hatch... in the Draw pull-down menu,
- Entering H, BH, or BHATCH at the Command: prompt.
Section Lines/Hatch Patterns

- Boundary Hatch dialog box
  - Quick tab. - Simplest.
  - Advanced tab. - Other options available.

- Buttons
  - Pick points
  - Select objects
  - Inherit properties.
  - Preview button.
Selecting a Hatch Pattern

- Select the hatch pattern
  - Quick tab of the Boundary Hatch dialog box.
  - Type: drop-down box.

- Three categories of hatch patterns are available:
  - Predefined.
  - User defined.
  - Custom.
Selecting a Hatch Pattern

- **Predefined Patterns:**
  - These predefined AutoCAD patterns are stored in the `acad.pat` and `acadiso.pat` files.

- **User defined Patterns.**
  - Selecting this option creates a pattern of lines based on the current linetype in your drawing.
  - You can control the angle and spacing of the lines.
Selecting a Hatch Pattern

- **Custom Patterns:**
  - Specifies a pattern that is defined in any custom .PAT File that you have added to the AutoCAD search path.

- Choose **Predefined** to use the patterns in the supplied acad.pat and acadiso.pat files.
Hatch Patterns
AutoCAD Hatch Patterns

- AutoCAD has standard section line symbols available, called hatch patterns.

- These symbols are located in the acad.pat file.
AutoCAD Hatch Patterns

- When very thin objects are sectioned, the material may be **completely filled in**.

- AutoCAD refers to this as **solid**.
AutoCAD Hatch Patterns

- When you change to a different hatch pattern, the new pattern becomes the default in the current drawing until it is changed.
Predefined Hatch Patterns
Predefined Hatch Patterns

- AutoCAD has many predefined hatch patterns.
- These patterns are contained in the acad.pat and acadiso.pat files.
Predefined Hatch Patterns

To select a predefined hatch pattern:

- Select **Predefined** in the **Type** drop-down list
- Select the predefined **pattern** from the drop-down list
  - OR
- Click the ellipsis (…) button to display the **Hatch Pattern Palette** dialog box.


**Predefined Hatch Patterns**

- **The Hatch Pattern Palette**
  - Provides sample images of the predefined hatch patterns.

- The hatch patterns are divided among the four tabs:
  - ANSI
  - ISO
  - Other Predefined
  - Custom.
Drawing Section Views and Graphic Patterns

Hatch Pattern Palette

[Image of Hatch Pattern Palette window with ISO tab selected, showing various hatch patterns like ISO02W100, ISO03W100, ISO04W100, ISO05W100, ISO06W100, ISO07W100, ISO08W100, ISO09W100, ISO10W100, ISO11W100, ISO12W100, ISO13W100, ISO14W100, ISO15W100]
Drawing Section Views and Graphic Patterns

The image shows a window titled "Hatch Pattern Palette" with tabs for ANSI, ISO, Other Predefined, and Custom. The Custom tab is highlighted, indicating that the custom hatch pattern is selected or about to be selected.
Predefined Hatch Patterns

- **Select** the desired **pattern**
- **Pick** the **OK** button to return to the Boundary Hatch dialog box.
  - The selected pattern is displayed in the **Swatch tile** and listed in the **Pattern: text box**.

- You can also access the Hatch Pattern Palette dialog box by picking the image displayed in the **Swatch tile**.
Predefined Hatch Patterns

**Angle**
- Controls the *angle*

**Scale**
- Controls the *scale*

- of any predefined pattern.
Boundary Hatch

Quick

Type: Predefined

Pattern: ANSI31

Swatch:

Custom pattern:

Angle: 0

Scale: 1.0000

Spacing: 1.0000

ISO pen width:

Advanced

Pick Points

Select Objects

Remove Islands

View Selections

Inherit Properties

Double

Composition

- Associative
- Nonassociative

Preview

OK

Cancel

Help
Predefined Hatch Patterns

For predefined ISO patterns (only), you can also control the ISO pen width using the ISO pen width: drop-down list.
### Boundary Hatch Settings

- **Type:** Predefined
- **Pattern:** ISO02W100
- **Swatch:**
- **Custom pattern:**
- **Angle:** 0
- **Scale:** 1.0000
- **Relative to paper space:**
- **Spacing:** 1.0000
- **ISO pen width:**
  - 0.13 mm
  - 0.18 mm
  - 0.25 mm
  - 0.35 mm
  - 0.50 mm
  - 0.70 mm

### Other Options
- **Pick Points**
- **Select Objects**
- **Remove Islands**
- **View Selections**
- **Inherit Properties**
- **Double**
- **Composition:**
  - Associative
  - Nonassociative

**Buttons:**
- Preview
- OK
- Cancel
- Help
An object can be hatched solid by selecting the SOLID predefined pattern.
User Defined Hatch Patterns

- A user defined hatch pattern is a pattern of lines drawn using the current linetype.

- The angle for the pattern relative to the X axis is set in the Angle: text box.

- The spacing between the lines is set in the Spacing: text box.
Drawing Section Views and Graphic Patterns

Boundary Hatch

Quick | Advanced

- **Type**: User defined
- **Pattern**: ANSI31
- **Swatch**:
- **Custom pattern**:
- **Angle**: 0
- **Scale**: 1.0000

- **Spacing**: 1.0000
- **ISO pen width**:

- **Relative to paper space**: unchecked

- **Double**: unchecked

- **Composition**:
  - **Associative**
  - **Nonassociative**

- **Pick Points**
- **Select Objects**
- **Remove Islands**
- **View Selections**
- **Inherit Properties**

- **Preview** | **OK** | **Cancel** | **Help**
User Defined Hatch Patterns

- Specify **double hatch lines** by selecting the **Double check box** on the right side of the Boundary Hatch dialog box.

- This check box is **only available** when **User defined is selected** in the Type: drop-down list.
Hatch Variables

- AutoCAD stores
  - The selected angle in the HPANG system variable.
  - The selected spacing in the HPSPACE system variable.
  - The setting of the Double check box in the HPDOUBLE system variable.
Hatch Pattern Scale
Hatch Pattern Scale

- Scale hatch patterns can be scaled by entering a value in the Scale: text box.
  - Common scales, broken down in 0.25 increments.
  - Range: 0.25 to 2.
  - You can type any scale in the text box.
  - AutoCAD stores the selected scale in the HPSCALE system variable.
- Default = 1
Hatch Pattern Scale

- **Relative to paper space check box**
  - Scales hatch pattern relative to paper space units.

- **Wizards** set the hatch pattern scale factor automatically based on the information you provide.
  - Settings are related to the full scale of the objects you draw.
Hatch Pattern Scale

- Use a larger scale factor when hatching large areas.
  - This makes your section lines look neater and saves regeneration time.
Selecting Areas To Be Hatched
Select areas to be hatched by one of two methods:

- Picking points.
- Selecting objects.
Selecting Areas to Be Hatched

- **Pick Points button**
  - Easiest method to hatch an area.
  - **Pick the button**.
  - *The drawing returns.*
  - **Pick a point within the region** to be hatched
  - **AutoCAD automatically defines the boundary around the selected point.**
Selecting Areas to Be Hatched

- The following prompts are displayed:
  - Select internal point: (pick a point inside the area to be hatched)
  - Selecting everything visible...
  - Analyzing the selected data...
  - Analyzing internal islands...
  - Select internal point: (pick an internal point of another object or [Enter] if you are done selecting objects)
Selecting Areas to Be Hatched

- More than one internal point can be selected.

- When you are finished selecting points,
  - Press [Enter]
  - The Boundary Hatch dialog box returns
  - Pick the OK button
  - The feature is automatically hatched.
Selecting Areas to Be Hatched

- Enter U or UNDO to undo the last selection, in case you picked the wrong area.
  - Undo the hatch pattern by entering U at the Command: prompt after the pattern is drawn.

- Preview the hatch before applying it to save time.
Selecting Areas to Be Hatched

- Use the Select Objects button to define the hatch boundary if you have items that you want to hatch by picking the object, rather than picking inside the object.
Selecting Areas to Be Hatched

- **Objects**
  - Circles
  - Polygons,
  - Closed polylines.

- Use the Select Objects button can also be used to pick an object inside an area to be hatched to exclude it from the hatch pattern.
Selecting Areas to Be Hatched

- Boundaries inside another boundary are known as islands.

- AutoCAD can either
  - Ignore these internal boundary objects and hatch through them
    - OR
  - Consider them as islands and hatch around them.
Selecting Areas to Be Hatched

- Islands are left unhatched by default.

- Pick the Remove Islands button in the Boundary Hatch dialog box after selecting the internal point to remove them.
Selecting Areas to Be Hatched

- The graphics window returns with the following prompts:
  - Select island to remove: (pick the islands to remove)
  - (Select island to remove)/Undo:
  - Press [Enter] to return to the dialog box.

- The island objects are now removed from the hatch boundary.
Selecting Areas to Be Hatched

- The **Advanced** tab of the Boundary Hatch dialog box allows you to **set**
  - The island detection style.
  - The island detection method.
Selecting Areas to Be Hatched

- If no islands exist, specifying an island detection style has no effect.

- Three options:
  - Normal.
  - Outer.
  - Ignore.
Selecting Areas to Be Hatched

- **Normal**.
  - Hatches **inward** from the **outer boundary**.
  - If AutoCAD **encounters an island**, it turns **off** hatching **until** it encounters **another island**, then **hatching is reactivated**.

- **Every other** closed boundary is hatched with this option.
Selecting Areas to Be Hatched

- **Outer**.
  - Hatches *inward* from the *outer boundary*.
  - AutoCAD turns *hatching off* when it encounters an *island* and DOES NOT turn it back on.
  - AutoCAD hatches only the outermost level of the structure and *leaves the internal structure blank*. 
Selecting Areas to Be Hatched

- Ignore
  - Ignores ALL islands
  - HATCHES EVERYTHING within the selected boundary.
Previewing The Hatch

- The Island detection method area has two options: **Flood** and **Ray** casting.
  - **Flood** is the default.
  - This setting leaves internal objects (islands) unhatched.

- **Ray** casting radio button hatches **through** islands.
Previewing The Hatch
Previewing The Hatch

- Preview tools
  - Hatch pattern correct
  - Hatch boundary settings correct.

- View Selections button.
- Preview button.
Previewing The Hatch

- **View Selections button.**
  - Shows the **boundaries** of selected objects.
  - The drawing is displayed with the hatch boundaries highlighted.
  - Press [Enter] or the **right mouse button to return** to the Boundary Hatch dialog box.
Previewing The Hatch

- **Preview button.**
  - Pick the Preview button before you apply it to the drawing.
  - AutoCAD temporarily places the hatch pattern.
  - When finished previewing the hatch, press [Enter] or the right mouse button.
  - The Boundary Hatch dialog box is displayed again.
  - Change the hatch pattern, scale, or rotation angle as needed and preview the hatch again.
Previewing The Hatch

- **Preview button.**
  - When you are satisfied with the preview of the hatch, pick the OK button to have it applied to the drawing.
Hatch Pattern Composition

- The BHATCH command creates associative hatch patterns by default.
- It can be set to create non-associative patterns.
**Hatch Pattern Composition**

- **Associative Hatch Patterns**
  - **Update automatically** when the boundary is edited.
  - **Automatically fill the new area** with the original hatch pattern if the boundary is stretched, scaled, or otherwise edited.
  - **Can be edited** using the `HATCHEDIT` command, which is discussed later in this chapter.
Hatch Pattern Composition

- **Non-associative hatch**
  - Is independent of its boundaries.
  - The hatch pattern DOES NOT CHANGE with the hatch boundary.
  - You must select both the boundary and the pattern before editing if you want to modify both.
Correcting Errors in the Boundary

- **BHATCH** works well unless you have an error in the hatch boundary.

- The most common error is a gap in the boundary.
  - This can be very small and difficult to detect
  - Occurs when you do not close the geometry or use object snaps for accuracy.
Correcting Errors in the Boundary

◆ Picking a point outside the boundary area
  ◆ Creates a Boundary Definition Error alert.
  ◆ Pick OK.

◆ Select a point inside the boundary you want hatched.
Improving Boundary Hatching Speed
Improving Boundary Hatching Speed

- Generally, boundary hatching works with satisfactory speed.

- Improve hatching speed and resolve other problems using options found in the Advanced tab in the Boundary Hatch dialog box.
**Improving Boundary Hatching Speed**

- The drop-down list in the Boundary set area specifies what is evaluated when hatching.

- The default setting is Current viewport.
You can limit what AutoCAD evaluates when hatching and define the boundary area so the BHATCH command only considers a specified portion of the drawing.
Improving Boundary Hatching Speed

- Pick the New button.
- At the Select objects: prompt, use a window to select the features of the object to be hatched.
Improving Boundary Hatching Speed

- You can make as many boundary sets as you wish.

- The last one made remains current until another is created.
Improving Boundary Hatching Speed

- The **Retain boundaries check box** can be selected as soon as a boundary set is made.

- **Checking this box**
  - Allows you to keep the boundary of a hatched area as a polyline.
  - Continues to save these as polylines every time you create a boundary area.
  - The default is no check in this box, so the hatched boundaries are not saved as polylines.
Improving Boundary Hatching Speed

◆ If the Retain boundaries check box is unchecked, the temporary boundaries are automatically removed when the hatch is complete.

◆ If you check the Retain boundaries check box, the hatch boundaries are kept when the hatch is completed.
Improving Boundary Hatching Speed

Two options:
- **Polyline** (the default)
- **Region**.

If **Polyline** is selected
- The boundary is a polyline object around the hatch area.

If **Region** is selected
- The hatch boundary is the hatched region.

A **region** is a closed two-dimensional area.
Hatching Tips
Hatching Tips

1. Zoom in on the area to be hatched

   It make it easier for you to define the boundary.

   The hatch process is much faster because AutoCAD does not have to search the entire drawing to find the hatch boundaries.
Hatching Tips

2. Preview the hatch before you apply it.
   - This allows you to easily make last minute adjustments.

3. Turn off layers where there are lines or text that might interfere with your ability to accurately define hatch boundaries.

4. Create boundary sets of small areas within a complex drawing to help save time.
Hatching around Text
Hatching around Text

◆ AutoCAD automatically places an imaginary box around the text in a hatch boundary.

◆ Hatch patterns are not placed inside these imaginary boxes.

◆ The text must also be selected as an element of the hatch boundary for this to work properly.
Hatching around Text

- Refer to Figure 22-28.
- Always place the text before hatching the area.
- Pick
  - the object to be hatched and
  - the text to be hatched around.
  - The object and the text are picked individually.
- You can also window both.
Editing Hatch Patterns
**Editing Hatch Patterns**

- Edit hatch boundaries and hatch patterns with grips and editing commands such as ERASE, COPY, MOVE, ROTATE, and SCALE.
Editing Hatch Patterns

Access the HATCHEDIT command by:

- Picking Hatch... in the Modify pull-down menu
  - OR
- Picking the Edit Hatch button on the Modify II toolbar
  - OR
- Entering HE or HATCHEDIT at the Command: prompt.
Editing Hatch Patterns

The command sequence is as follows:
- Command: HE or HATCHEDIT-
- Select associative hatch object: (pick the hatch pattern to edit)
The Hatch Edit dialog box is displayed.

The Hatch Edit dialog box has the same features as the Boundary Hatch dialog box, except that only the items that control hatch pattern characteristics are available.
**Editing Hatch Patterns**

- You can
  - Change the pattern type, scale, or angle;
  - Remove the associative qualities;
  - Set the inherit properties of an existing hatch pattern;
  - Use the Advanced tab options to edit the hatch pattern.
  - Preview the edited hatch before applying it to your drawing.
Drawing Objects with Solid Fills
The SOLID Command
**Drawing Objects with Solid Fills**

- Polylines, polyarcs, trace segments, and doughnuts may be filled in solid when FILL mode is on.

- When FILL is off, these objects are drawn as outlines only.
Drawing Objects with Solid Fills

- The **SOLID** command works in much the same manner **except** that
  - it fills objects or shapes **that are already drawn** and
  - it fills areas that are simply defined by picking points.
The **SOLID** command is accessed by:

- Picking the **2D Solid button** from the **Surfaces toolbar**
  - OR
- Picking **2D Solid** from the **Surfaces cascading menu** in the **Draw pull-down menu**,
  - OR
- Entering **SO** or **SOLID** at the Command: prompt.
Drawing Objects with Solid Fills

- You are then prompted to select points.
- Rectangular objects:
  - Pick the corners in the numbered sequence.

- AutoCAD prompts you for another third point after the first four.
AutoCAD assumes that the third and fourth points of the previous solid are now points one and two for the next solid.

The subsequent points you select fill in the object in a triangular fashion.
Drawing Objects with Solid Fills

◆ Continue picking points, or press [Enter] to stop.
**Drawing Objects with Solid Fills**

- Alter the numbering sequence to draw different types of solid arrangements.

- Also, the SOLID command can be used to draw filled shapes without prior use of the LINE, PLINE, or RECTANG commands.

- Simply pick the points.
Drawing Objects with Solid Fills

Consider using various object snap modes when picking the points of existing geometry.
Using the Solid hatch pattern is an excellent way to create solid objects.

**To fill a circle**
- Use the DONUT command
- Set the inside diameter to 0 (zero),
  - OR
- Hatch the circle with the Solid hatch pattern.
Drawing Objects with Solid Fills

- Keep in mind that many solids and dense hatches require extensive regeneration.

- On a complex drawing, create filled solids and hatching on a separate layer and keep the layer frozen until you are ready to plot the drawing.
**Drawing Objects with Solid Fills**

- Many solids and dense hatch patterns also adversely affect plot time.

- Save plotting time by making check plots with FILL mode off.
Hatching at the Command: Prompt
Hatching at the Command: Prompt

- Enter `-H` (a hyphen followed by H) or `HATCH` at the Command: prompt.
Hatching at the Command: Prompt

- Command: -H or HATCH
- Enter pattern name or [/?/Solid/User defined] <ANSI31>:
- Entering ? gives you this prompt:
- Enter pattern(s) to list <*>:
- Enter the name or names of specific hatch patterns,
  - OR
- Press [Enter] to list all the hatch patterns.
To create a user defined hatch pattern, select the User defined option. You are then prompted to enter an angle and spacing.

The island detection method can be specified when the hatch pattern is selected.
Hatching at the Command: Prompt

The three style options are:
- Normal (hatches every other feature),
- Outer (hatches outermost feature area only),
- Ignore (ignores all interior features and hatches the entire object).

Any one of the options can be used by typing the desired pattern followed by a comma and the option.
For example, entering NET3,0 at the Enter pattern name or [?/Solid/User defined] prompt results in:

- The Outer island detection style being used with the Net3 hatch pattern.
- After selecting the pattern, you are then asked to define the pattern scale and angle.
**Hatching at the Command: Prompt**

- Enter pattern name or [?/Solid/User defined] <ANSI31>: j
- Specify a scale for the pattern <1.0000>: j
- Specify an angle for the pattern <O>: j
Hatching at the Command: Prompt

- Specify the hatch scale referencing model space, if desired.
- However, it is much simpler to reference the scale to paper space.
- This allows the scale factor to be based on the plotted scale of the drawing.
Hatching at the Command: Prompt

- To do this, enter XP after the scale.
- For example, entering 1 XP as the scale factor causes AutoCAD to automatically calculate the actual scale required within model space to match the specified value of 1 in paper space:
  - Specify a scale for the pattern <1.0000>: 1 XP
Hatching at the Command: Prompt

- You can also enter values for this prompt by picking two points in the drawing.
- AutoCAD then measures the distance and uses it as the scale factor.
- This method does not allow the XP option to be used.
**Hatching at the Command: Prompt**

- After setting the scale and angle, the following prompt appears:
  - Select objects to define hatch boundary or `<direct hatch>`,
  - Select objects:
Hatching at the Command: Prompt

- The area to be hatched is defined by selecting objects.
- **There is no option to define the boundary by selecting an internal point.**
- However, you can press [Enter] at the Select objects: prompt to activate the **direct hatch option**.
Hatching at the Command: Prompt

- When using the **direct hatch option**, you define the boundary by selecting points. The following prompts appear:
  - Select objects to define hatch boundary or `<direct hatch>`,
  - Select objects: (press [Enter] to access the direct hatch option)
  - Retain polyline boundary? [Yes/No] <N>:.j
**Hatching at the Command: Prompt**

- The **direct hatching option** places a **polyline boundary** around the area to be hatched.

- You can keep the polyline or delete it based on your response to the Retain polyline boundary? [Yes/No]: prompt.
Hatching at the Command: Prompt

◆ When you pick the first point of the polyline boundary, you get options that are just like the PLINE command:

◆ Specify start point: (pick start point)

◆ Specify next point or [Arc/CLOSE/Length/Undol]: (specify corners of boundary)

◆ Specify next point or [Arc/CLOSE/Length/Undo]:

◆ Specify start point for new boundary or <apply hatch>: (press [Enter] to apply hatch pattern or select another point to define another boundary)
Hatching at the Command: Prompt

- You can draw another polyline boundary or you can press [Enter] to have the hatch drawn in the boundary you just finished.
- You do not have to draw a hatch pattern in a predefined area.
- You can draw a hatch pattern anyplace using the direct hatching method.
NOTE  As previously mentioned, an associative pattern is a hatch pattern that is automatically updated when an object is edited.

Patterns drawn with the HATCH command are non-associative.
This means that if you pick only the hatch boundary to edit, the hatch pattern does not change with it.
Making Individual Line Hatch Patterns
Making Individual Line Hatch Patterns

- When you use the HATCH command and draw a hatch pattern using any of the designated hatch names, the pattern is drawn as a block.
- The entire hatch pattern acts as one object.
Making Individual Line Hatch Patterns

- If you pick one line of the pattern to erase, the entire hatch pattern is erased.
Making Individual Line Hatch Patterns

- You can make each line of the hatch pattern an individual object by typing an asterisk (*) before the hatch pattern name:

  - Command: -H or HATCH
  - Enter a pattern name or [/?/Solid/User defined] <ANSI31>: *ANSI31.
Making Individual Line Hatch Patterns

- The rest of the command sequence works as previously discussed.
- Now, each line in the hatch pattern is a single object.
- This allows you to edit the lines individually.
- Include all the lines in a selection set if you want to edit them together.
Making Individual Line Hatch Patterns

- The individual line hatch pattern remains as default until changed.
- Be sure to change it if you want to draw the next hatch pattern as a block.
- A hatch pattern can also be exploded to create individual lines.